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Satnica obuke Windows  
(Seminar traje 5 dana) 

I dan 
08:00 Uvodno predavanje 

Opšte predavanje o računarima i operativnim sistemima 
08:45 Pauza 
09:00 Prvi Windows koraci 

Osnovni izgled ekrana, desktop, taskabar,... 
09:45 Pauza 
10:00 Startovanje programa  i podešavanje YU karakteristika 

Startovanje programa, rad sa WordPad-om i Paint-om  
10:45 Pauza 
11:00 Windows Explorer 

Pravljenje fascikli i podfascikli 
12:00 Kraj rada 

II dan 
08:00 Obnavljanje znanja 

Polaznici uz pomoć priručnika ponavljaju akcije koje su naučili 
08:45 Pauza 
09:00 Kreiranje svojih dokumenata i smeštanje u fascikle 

Kreiranje slika i dokumenata, smeštanje slika i dokumenata u 
fascikle 

09:45 Pauza 
10:00  Windows explorer  

Kopiranje i premeštanje objekata. 
10:45 Pauza 
11:00 Windows explorer, formatiranje disketa 

Promena naziva i brisanje objekata. Formatiranje diskete i 
prenošenje podataka 

12:00 Kraj rada 

III dan 
08:00 Obnavljanje znanja 

Polaznici uz pomoć priručnika ponavljaju akcije koje su naučili 
08:45 Pauza 
09:00 Provere polaznika 

Proverava se rukovanje podacima u Windows explorer-u 
10:00  Podešavanje sistema 

Podešavanje taskbar-a i Control Panela-a 
10:45 Pauza 
11:00 Izbor i instalacija fontova i podešavanje štampača 

Rad sa font menadžerom. Instalacija i podešavanje štampača 
12:00 Kraj rada 

IV dan 
08:00 Obnavljanje znanja 



Windows operativni sistem  Strana 5 

 

Polaznici uz pomoć priručnika ponavljaju akcije koje su naučili 
08:45 Pauza 
09:00 Održavanje diska 

Back up, scan disk,... 
09:45 Pauza 
10:00 Rad u mreži  

Podešavanje parametara mreže, .... 
10:45 Pauza 
11:00 Korišćenje DOS programa, Arhivirianje podataka 

Rad sa nekim arhiverom (Win ZIP, Win Rar) 
12:00 Kraj rada 

V dan 
08:00 Obnavljanje znanja 

Polaznici uz pomoć priručnika ponavljaju akcije koje su naučili 
08:45 Pauza 
09:00 Rekapitulacija seminara i priprema za ispit 
09:45 Pauza 
10:00 Teorijski deo ispita – I grupa 
11:15 Pauza 
11:30 Ocena zadovoljnosti kupca. 
12:00 Pauza 
12:15 Teorijski deo ispita – II grupa 
13:30 Pauza 
13:45 Ocena zadovoljnosti kupca 
14:15 Kraj rada 
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1. Šta je računar? 

1.1 Upoznajte svoj računar 
Već ste ranije znali da napišete neki dokument da napravite neki proračun, 
da nacrtate neki crtež ili grafikon. Međutim sve ove zadatke sada možete 
brže i bolje da uradite koristeći računar.  

Računar čine nekoliko hardverskih komponenti: 
• Sistemska jedinica  
• Monitor  
• Tastatura  
• Miš 
• Dodatna oprema (zvučnici, štampač, skener…) 

1.1.1 Sistemska jedinica 
Najbitnija komponenta računara je sistemska jedinicia. 
Sistemsku jedinicu čini procesor, hard disk, grafička 
karta, zvučna karta, flopi disk, … Komponente 
sistemske jedinice brinu o svim operacijama koje se 

izvode, o čuvanju podataka i itd. Zbog toga se kaže da je sistemska jedinica 
srce računara.  

1.1.2 Monitor 
Monitor je komponenta računara koja po izgledu podseća na TV ekran. 
Slike i poruke koje generiše računar su prikazane na monitoru. Monitor 
služi da Vam olakša komunikaciju sa računarom. Pored monitora, za 
komunikaciju sa računarom služe još i tastatura i monitor. 

1.1.3 Tastatura 
Tastatura Vam omogućava da računaru prenesete informaciju ili komandu. 
Tastatura ima nekoliko vidno izdvojenih celina: 

1. osnovna 
2. numerička 
3. funkcijska 
4. specijalni tasteri 

1.1.3.1 Osnovna 
Ova celina tastature sadrži tastere kao i 
klasična pisaća mašina. Preko ovih 

tastera kucamo tekst koji se vidi na ekranu monitora. 

1.1.3.2 Numerička 
Nemaju sve tastature posebno izdvojene numeričke tastere. Ova celina 
omogućava lakši rad sa numeričkom tastaturom ukoliko računar koristite za 
neke proračune. 

3 4

2 

1 

5

1 2

3 4 
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1.1.3.3 Funkcijska 
Tasteri u ovom delu tastature se nazivaju funkcijski tasteri (F1 – F12). Ovi 
tasteri Vam omogućavaju da u pojedinim programima brzo odradite neku 
akciju (npr. F1 u svim programima poziva pomoć). 

1.1.3.4 Specijalni tasteri 
Specijalni tasteri izvode neke specijalne funkcije. Na primer taster ESCAPE 
(Esc) se koristi ta prekine trenutno započetu akciju. Takođe se ovi tasteri 
(Alt i  Ctrl) koriste se u kombinaciji sa drugim tasterima kako bi se brže 
izvršile pojedine akcije. 

1.1.4 Miš 
Pored tastature, za komunikaciju sa računarom mogu se koristiti i razni 
pokazivački izvori. Njapopularniji pokazivački uređaj je miš. Pokazivač koji 
koristi miš se vidi na ekranu u obliku strelice i tako se i zove. Strelica 
pokazuje gde se trenutno nalazite na ekranu. Uz pomoć miša moguće je 
uraditi četiri osnovne operacije: 
• Selektovanje (ili pokazivanje, ili izbor) 
• Klik 
• Dupli-klik 
• Prevlačenje 

1.1.4.1 Selektovanje 
Uz pomoć strelice možete odrediti gde se trenutno nalazite na ekranu. 
Primetite da kako Vi pomerate miša po stolu da se tako strelica pokreće na 
ekranu te stoga trebate miša shvatiti kao produžetak svoje ruke. Primetite 
takođe da kada pređete mišem preko nekog objekta na ekranu da se pojedini 
objekti menjaju. 

1.1.4.2 Klik 
Sledeća akcija je klik. Pod pojmom klik se podrazumeva da jednom 
pretisnete levo dugme miša. Rezultat ove akcije zavisi od programa sa 
kojim radite. 

1.1.4.3 Dupli-klik 
Dupli-klik podrazumeva da dva puta u veoma kratkom vremenskom periodu 
pretisnete levo dugme miša.  

1.1.4.4 Prevlačenje 
Prevlačenje objekta na ekranu se radi na sledeći način: postavite strelicu 
iznad objekta, pritisnite levi taster miša i dršite ga sve vreme dok traje 
prevlačenje, i pomerajte miša dok ne dođete objektom na željeno mesto i 
tada pustite levi taster miša. 
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2. Operativni sistem 
WINDOWS 9x je novija verzija operativnog sistema američkog 
proizvođača Microsoft namenjena personalnim računarima sa IBM PC 
arhitekturom i procesorom Intel 80386 ili novijim. Radi se o specijalnom 
programu koji obezbeđuje osnovne funkcije upravljanja računarskim 
komponentama i pod čijom kontrolom se izvršavaju svi drugi korisnički 
programi namenjeni raznim potrebama (aplikacije). 

Obzirom da operativni sistem upravlja funkcionisanjem računara, stvara 
potrebnu radnu okolinu za sve ostale programe i ostvaruje vezu između 
računara i korisnika prijemom komandi i prikazivanjem rezultata rada, 
poznavanje njegove upotrebe je do presudnog značaja za potpuno 
iskorišćavanje mogućnosti računara. Ovladavanje operativnim sistemom 
treba da bude prvi korak u obuci za rad na računarima i temelj svih kasnijih 
saznanja vezanih za specifične oblasti njihove primene u svakodnevnim 
poslovima. 

Osnovna uloga operativnog sistema je da bude prevodilac između čoveka i 
mašine, što razumljiviji prema čoveku, a što efikasniji prema spletu 
digitalne elektronike i precizne mehanike koja sačinjava računar. Dizajneri 
su novim izgledom pokušali da reše zadatak što prirodnijeg predstavljanja 
računarskih resursda korisniku na jednostavan način. Rešenje koje je 
ponućeno predstavlja rezultat obimnih istraživanja i ispitivanja velikog 
broja uzoraka iz raznovrsnih ciljnih grupa korisnika. 
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3. Prvi Windows koraci 

3.1 Osnovni izgled ekrana 
Ekran je u WINDOWS 9x podeljen na dva osnovna dela. Najveći deo 
predstavlja radnu površinu (Desktop) na kojoj se odvijaju sve aktivnosti 
programa. Drugi deo je mnogo manji i nalazi se na dnu ekrana. On se zove 
Taskbar i predstavlja liniju sa koje se pokreću aplikacije, prelazi iz jedne u 
drugu, prikazuje status rada i drugo.  

 

3.2 Radna površina (Desktop) 
Desktop je osnovna radna površina na kojoj se odvijaju sve aktivnosti 
aplikacija. Može se posmatrati kao obična pozadina svih ostalih objekata na 
ekranu, ali desktop predstavlja mnogo više od toga. To je objekat sa svojim 
osobinama, koje se mogu prilagođavati potrebama i na sebi može “držati” 
razne druge objekte u obliku njihovih grafičkih simbola, ikona ili otvorenih 
prozora u kojima se zadaju komande aplikacije i ispisuju rezultati njenog 
rada. 

Objekti koji se mogu naći na desktop-u su ikone aplikacija (ili njihovi 
prozori kada su aktivne), datoteka, kataloga (folders), zatim pokazivači na 
njih, pokazivači na uređaje, mreže i drugi. Međutim, na desktop-u se obično 
čuvaju samo objekti koji se najčešće koriste. U računaru može biti na stotine 
programa i datoteka, pa bi desktop bio nepregledan ako bi sve stavljali na 
njega. Uostalom, nikada ne držimo na stolu sav kancelarijski materjal, već 
ponešto odložimo i u fioke dok nam ne zatreba. 

3.3 Komandna linija (Taskbar) 
Taskbar se može posmatrati kao centralna komandna tabla sa koje se 
pokreću aplikacije, prelazi iz jedne u drugu, dobija status rada i slično. 
Inicijalno se nalazi na dnu ekrana i uvek je vidljiv, jer se postavlja iznad 

Taskbar 

Ikone 
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svih aktivnih prozora i aplikacija, mada se njegov položaj, veličina i druge 
osobine mogu po potrebi promeniti. 

 

Taskbar se sastoji od tri osnovna segmenta. U levom uglu je dugme Start 
preko koga se pokreću sve instalirane aplikacije i zadaju razne sistemske 
komande. U desnom uglu se statusno polje (notification area)  preko koga se 
prati stanje sistema, odnosno raznih programa koji se izvršavaju u pozadini, 
bez otvaranja prozora i dugmeta na taskbar-u. Tu se može nalaziti časovnik, 
komanda za podešavanje jačine zvuka (sličica zvučnika), komanda za 
praćenje toka štampanja (sličica štampača koja se pojavi kada je štampanje 
u toku), tok modemske ili faks veze (sličica modema), simbol za izbor 
aktivnog tastaturnog rasporeda ukoliko je instalirano više njih itd. Ako par 
sekundi zadržite pokazivač iznad ovi sličica, dobićete dodatne informacije, a 
dvostrukim klikom se pokreće aplikacija za upravljanje njihovim radom. 

Centralni deo taskbar-a rezervisan je za dugmad trenutno aktivnihg 
aplikacija. Pri pokretanju aplikacija ovde se pojavljuju njihovi grafički 
simboli u obliku dugmeta (tastera), što omogućava da se na jednom mestu 
prate svi pokrenuti programi i da se jednostavnim pritiskom na dugme 
nekog od njih izabere ona sa kojom se trenutno radi. Ovaj deo taskbar-a se , 
dakle, može posmatrati kao birač kanala na televizoru. 

3.4 Način rada pod WINDOWS 9x 
Osnovna ideja operartivnih sistema koji su grafički orijentisani je što 
prirodnija upotreba računara. Glavni cilj je koristiti kompjuter na vizuelno 
jasan način, sledeći logiku upotrebe raznih drugih predmeta i alatki iz 
svakodnevnog života. Komande koje korisnik upućuje računaru treba da se 
unose na “pokazivački” način koji se koristi i u stvarnom svetu. Zbog toga 
je izmišljen miš, jednostavni pokazivački uređaj na kome je zasnovan dobar 
deo upravljanja Windows operativnim sistemom. Drugi uredjaj koji se 
koristi za komandovanje je tastatura, neophodna za unošenje tekstova, 
brojnih podataka i slično. 

3.5 Pokretanje programa 
Dugme Start u levom donjem uglu ekrana služi za pokretanje instaliranih 
aplikacija i aktiviranje sistemskih komandi. Dovedemo pokazivač miša na 
to dugme i pritisnemo levi taster. Kao rezultat pojaviće se lista komandi 
odnosno meni. Sada iz menija treba izabrati neku stavku ili odustati od 
izbora. Odustajanje se vrši tako što kliknemo mišem negde na praznom 
prostoru desktop-a, ili pritiskom na taster Esc.  

Start meni ima tri dela. U donjem delu su osnovne funkcije kao što su Shut 
Down, Log Off… U srednjem delu se nalaze opcije za pokretanje raznih 
programa, otvaranje dokumenta i podešavanje sistema. Gornji deo start 

Start dugme Dugmad programa Statusno polje
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menija je lični deo strat menija. U njemu Vi postavljate opcije koje često 
koristite u radu na računaru. 

Ako dovedemo pokazivač na stavku Programs Start menija, posle par 
sekundi pojavljuje se nova lista. Sadržaj dobijene podliste zavisi od 
instaliranih programa. Ako izaberemo stavku Accessories i pojavljuje se 
treća lista koja sadrži same programe. Dovedemo pokazivač do programa 
WordPad i kliknemo levim tasterom. Upravo smo pokrenuli program 
WordPad pod WINDOWS 9x operativnim sistemom. 

Pritiskom na kombinaciju tastera Ctrl+Esc aktivira se Start meni ( što je 
alternativa pritisku mišem na Start dugme). Korišćenjem kursorskih strelica, 
i Enter tastera krećemo kroz liste i podliste Start menija. 

3.6 Osnovni elementi prozora 
Windows je operativni sistem u kome se istovremeno može pokrenuti više 
programa (multitasking). Svaka aplikacija dobija svoj pravougaoni prostor 
na ekranu koji se naziva prozor (window). Veličinu i položaj tog prozora 
korisnik slobodno podešava. 

Važna osobina Windows-a je i jednobraznost svih aplikacija koje se pod 
njim startuju. Zbog toga ćete, pošto ovladate upotrebom jednog programa, 
vrlo lako koristiti i svaki drugi,uz malo poznavanje engleskog jezika i 
proučavanje specifičnosti date aplikacije. 

Svaki prozor ima naslovnu liniju (title bar) sa nazivom aplikacije (caption) 
koja se u njemu izvršava.Hvatanjem naslova uz pomoć kursora miša i 
njegovim prevlačenjem čitav program se pomera po ekranu. Ivice prozora 
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imaju posebnu ulogu: njihovim prevlačenjem se menjaju dimenzije 
standarnih prozora. Dovedite pokazivač na neku od horizontalnih ili 
vertikalnih ivica, njegov oblik će se promeniti u dvostrane strelice, koje 
pokazuju smer mogućeg prevlačenja. Ukoliko se u tom položaju pritisne 
levi taster miša i miš pomera, izabrana ivica prati smer pomeranja. 
Otpuštanjem tastera prozor se skalira na novu veličinu. Uglovi prozora, kao 
spojevi dve ivice, omogućavaju da se dimenzija prozora istovremeno 
menjaju i po horizontali i po vertikali. 

Tri dugmeta u gornjem desnom uglu prozora imaju specijalnu namenu. Klik 
mišem na prvo dugme sleva umanjuje prozor, a prisustvo aplikacije 
označava se dugmetom na taskbar-u. Klik na to dugme vratiće prozoru 
njegovu prvobitnu poziciju i dimenzije. 

Srednje dugme u desnom gornjem uglu prozora uvećava prozor na sav 
raspoloživ prostor na ekranu. Ponovni pritisak na isto dugme vraća prozor 
na iste dimenzije. 

Treće dugme , na kome je stilizovano “X”, služi za zatvaranje aplikacije i 
time se prekida dalji rad sa tim programom. 

U levom gornjem uglu prozora nalazi se grafički simbol aplikacije koja se u 
njemu izvršava. Klikom na taj simbol dobija se lista sa komandama koje 
smo upravo opisali. Restore vraća dimenzije prozora na početne, Move 
premešta prozor na novu lokaciju, Size menja dimenzije prozora, Minimize 
minimizira prozor, Maximize ga uvećava na celu površinu desktop-a, dok se 
izborom komande Close zatvara aplikacija i time završava njeno 
izvršavanje. 

Kod Windows-a se ista stvar obično može postići na više različitih načina, 
pa su tako i sve opisane operacije pristupačne i preko tastature. 

Da bismo objasnili osnove rada sa WINDOWS 9x programom, 
startovaćemo program WordPad (u Start meniju aktiviramo stavku 
Programs, zatim u otvorenoj listi stavku Accessories i na kraju u 
novootvorenoj listi  stavku WordPad).  Centralni deo aplikacije zauzima 

Naslovna linija Dugmeta za 
podešavanje 

prozora 
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radni prostor (application workspaces) u kome se unose podaci. Kod 
programa za obradu teksta, na primer, radni prostor sadrži sam tekst koji se 
unosi (unesite nekoliko rečenica u pokrenuti WordPad). Tekst se pojavljuje 
na mestu kursora koji ima oblik vertikalne trepćuće crtice. Dokument može 
biti mnogo veći od prozora u kome se unosi. Za pregled celog dokumenta 
koriste se klizači (scroll bars) uz donju i desnu ivicu prozora. 

Meniji su pregledno organizovane liste komandi koje se u datom trenutku 
mogu izabrati. U svim Windows aplikacijama ispod naslovne linije prozora 
nalazi se linija sa listama komandi. Liste  se otvaraju klikom na neki od 
naziva u meniju. Komande ispisane bleđim slovom u datoj situaciji se ne 
mogu aktivirati. Pojedine stavke mogu biti nazivi novih lista komandi, koje 
se dalje mogu otvarati kaskadno- prepozanaju se po maloj strelici desno od 
naziva. Neke komande u listi su prekidači koji mogu biti uključeni 
(checked) što se označava “štriklom” ili isključeni(unchecked). 

Dobar deo komandnih listi (menija) karakteriše većinu aplikacija, pa je 
snalaženje olakšano. 

U nazivima lista i samih komandi uvek postoji po jedno podvučeno slovo, 
na osnovu koga se ta komanda bira sa tastature. Uz pritisak taster Alt otkuca 
se neko od podvučenih slova u meniju, čime se otvara lista sa tim nazivom. 

Pojedine komande izvršavaju se jako često, pa nije racionalno tražiti ih po 
menijima i listama. Zbog toga je ostavljena mogućnost upotrebe kontrolne 
table sa dugmićima, koja se postavi ispod menija: pritisak na dugme 
direktno poziva naredbu čiji je stilizovani grafički simbol na njemu nacrtan. 

U mnoštvu grafičkih simbola često nije lako pogoditi šta koji od njih 
označava- najzad, neki simbol ne mora vas asocirati na ono na šta je 
asocirao autora programa. Zbog toga aplikacije pisane za WINDOWS 9x 
podržavaju  prikaz kratkih napomena (tooltip) koje se pojave ako pokazivač 
miša stoji par sekundi iznad nekog objekta (npr. dugmeta), bez klika.  

Naziv komande nije uvek dovoljan da korisnik zaključi čemu ona služi, 
pogotovu ako tek ovladava novim programom. Dodatnu pomoć pruža linija 
za poruke (message bar) koja se nalazi na dnu prozora većine aplikacija. 
Kada se pokazivač miša zadrži iznad nekog dugmeta na toolbar-u, neće se 
samo pojaviti tooltip prozorčić već i rečenica u statusnoj liniji koja će 
pojasniti ulogu dotičnog tastera. Slično važi i za šetnju kroz menije - 
statusna linija, poput vodiča, objašnjava čemu trenutno izabrana komanda 
služi. 

Najpotrebnije komande se obično mogu zadavati i sa tastature, korišćenjem 
kombinacije tastera koja se zove hot key. U te svrhe se obično koriste 
funkcijski tasteri ili slova u kombinaciji sa Ctrl ili Alt modifikatorima. Ove 
kombinacije su u menijima naznačene desno od imena pridružene komande. 

3.7 Dijalog prozori 
Većina aplikacija se izvršava u jednom prozoru, ali za potrebe raznih unosa 
podataka koriste se i dodatni dijalog prozori. U nekim slučajevima to će biti 
opšti dijalog prozori koje kontroliše sam WINDOWS 9x (izbor datoteke, 
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podešavanja štampača, liste osobina objektat...), što znači da se poslovi iz 
svih aplikacija obavljaju na isti način. Postoje, naravno, i dijalog prozori 
specifični za konkretne aplikacije. 

3.8 Nazivi datoteka 
Naziv datoteke se sastoji iz dva segmenta razdvojena tačkom. Prvi deo je 
samo ime, a iza tačke se nalazi tzv. ekstenzija koja se može posmatrati kao 
prezime ili tip. Tip određuje vrstu dokumenta i najčešće se sastoji od tri 
slova: svi doklumenti treba da imaju ekstenziju .DOC, programi se 
prepoznaju po .EXE, slike po .BMP ili .PCX itd. Naziv datoteke može biti 
dug do 255 karaktera i može se sastojati od slova, razmaka i nekih 
specijalnih simbola (!@#$%^&ž’čšć[]+=;) , mada specijalne simbole treba 
izbegavati. U nazivima se razlikuju velika i mala slova. 

3.9 Rad sa više prozora 
WINDOWS 9x, kao što smo videli, omogućava istovremeno pokretanje više 
aplikacija, od kojih svaka može otvoriti jedan ili više prozora.  

Pokrenimo nekoliko programa: komandom Start->Programs->Accessories-
>WordPad aktiviramo WordPad, zatim sa Start->Programs->Accessories-
>Paint pokrenemo program za crtanje Paint i najzad sa Start->Programs-
>Accessories->Games->Free Cell pokrenemo igru sa kartama. Prozori sve 
tri startovane aplikacije nalaze se istovremeno otvoreni na desktop-u i 
delimičmo (ili potpuno) se pokrivaju, poput razbacanih listova papira po 
stolu. Uvek se samo jedna “nalazi u fokusu” i ona prima komande koje 
trenutno upućuje korisnik. Aplikacija koja je trenutno u fokusu i na koju se 
odnose sve komande sa tastature ima promenjenu boju naslovne linije 
prozora, a njeno dugme na taskbar liniji je “pritisnuto”.  

Dovođenje prozora u fokus se postiže na više načina , a osnovni su: 
• klik mišem na dugme željene aplikacije u taskbar delu. 
• držanjem tastera Alt i pritiskanjem Tab-a prebacuje se fokus između 

svih aktivnih aplikacija, uz mali dijalog sa njihovim simbolima koji se 
tom prilikom pojavi. 

• klik mišem na bilo koji vidljivi deo prozora (ako prozor nije potpuno 
zaklonjen). 

Prozori mogu da se raspoređuju ručno, na način koji smo već opisali, ili se 
može narediti njihovo automatsko slaganje (window arrange). Klikom 
desnim tasterom miša na prazan deo taskbar linije u dnu ekrana dobija se 
lista komandi. 

Naredbom Cascade svi otvoreni prozori se preurede tako što se kaskadno 
poređaju jedan iza drugog. Tile Horizontally će presložiti prozore tako da se 
rasporede po horizontali jedan do drugog, dok će ih Tile Vertically složiti po 
vertikali. Najzad, Minimize All Windows će sve otvorene prozore 
minimizovati. Prethodno izveden zahvat nad prozorima može da se poništi 
Undo komandom. 
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3.10 Izlazak iz Windows-a 
Operativni sistemi namenjeni izvršavanju više aplikacija i procesa 

istovremeno zahtevaju propisnu proceduru isključivanja 
računara. Za razliku od DOS-a , pod WINDOWS 9x se ne 
sme jednostavno ugasiti ili resetovati računar!  

Propisana procedura regularnog izlaska iz WINDOWS 9x je 
: Start->Shut Down... sa Taskbar komandne linije. Postoje 
četiri načina za izlazak iz WINDOWS 9x:  

• Shut down the computer izvodi pripremu za isključivanje 
računara. Važno je da se to uradi na kraju rada. 

• Restart the computer izvodi restartovanje, odnosno obaranje 
operativnog sistema i njegovo ponovo startovanje sa diska. 

• Restart the computer in MS-DOS mode izaziva prelaz iz 
grafičkog okruženja u DOS mod, tekst okolinu koja veoma liči na 
prethodne verzije DOS-a. 

• Close all programs and log on as a different user takođe vrši 
restart operativnog sistema, uz mogućnost prijavljivanja drugog 
korisnika za rad na mreži. 

Pošto se izabere jedna od četiri ponuđene opcije i klikne na dugme Yes, 
počinje Shut Down procedura koja najpre proziva sve aktivne aplikacije i 
upućuje im zahtev da završe sa radom i uklone se. Ukoliko neka od njih 
zahteva intervenciju korisnika pre isključenja (recimo postoje podaci koji 
nisu snimljeni), biće prikazan odgovarajući dijalog. 

Kada se pojavi poruka It’s now safe to turn off your computer, računar se 
može bezbedno isključiti. 

3.11 Help sistem 
 
Jedan od najjačih WINDOWS 9x oružja je moćan 
sistem za pružanje pomoći korisniku (help). Sistem 
za pomoć se sastoji od integrisanih baza podataka sa 
uputstvima na razne teme i aplikacije koja upravlja 
prikazom help-a i obezbećuje da se u svakom 
trenutku dojie odgovarajuća pomoć. 

Windows help sistem je hipertekstualan. To znači da 
su teme unutar help-a međusobno povezane, tako da 
upućuju jedna na drugu, a korisnik bira redosled 
ispisivanja objašnjenja. 

Generalno , sistem za pomoć se poziva preko Start-
>Help komande sa taskbar-a . Pojavljuje se prozor sa 
opštom listom sadržaja uputstva. Da bi se prešlo na 

detaljnije teme, treba odabrati neki od naslova iz liste dvostrukim klikom 
miša ili dovođenjem kurzota i pritiskom na Enter. Time se tema “otvara”, 
što simbolizuje otvaranje stilizovane knjižice uz naziv teme. 
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Tema može imati nove podteme (knjižice), i tako dok se ne doće do 
konkretnog odgovora na konkretna pitanja(listovi sa upitnikom). 

Za reči podvučene isprekidanom linijom može se dobiti pojašnjenje preko 
malog pop-up prozora koji se pojavi kada se na njih klikne (pokazivač iznad 
ovakvih reči menja oblik u “ruku”). Treba zapaziti i dugme Related Topics 
u dnu prozora sa objašnjenjem. Klikom na njega se dobija lista srodnih tema 
iz koje se može ići dalje u pretraživanje. 

U vrhu prozora sa objašnjenjima nalaze se komande za dobijanje osnovne 
liste tema (Help Topics), povratak na prethodno objašnjenje (Back) i 
podešavanje opcija (Options), gde se mogu izabrati slova za ispis ili narediti 
da prozor sa uputstvima uvek bude ispred ostalih (Keep Help on Top). 
Objašnjenje se takođe može iskopirati (Copy) na Clipboard (o njemu 
kasnije) ili odštampati (Print), a mogu se dodati i sopstvene beleške 
(Annotate). 

3.12 Pomoć u aplikacijama 
Pored opšteg helpa na nivou operativnog sistema, skoro svaka aplikacija 
ima i sopstveni sistem davanja uputstva za rad u njoj. Ovaj sistem se poziva 
iz menija , preko liste Help koja se nalazi na desnoj strani menu bar linije. 
Izborom Help Topics , Contents ili slične komande iz ove liste dobija se 
sadržaj aplikativnog uputstva. Način upotrebe je potpuno isti, s tim što su 
teme u ovom uputstvu usko vezane za konkretnu aplikaciju. 
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4. Yu karakteristike 
Da bi se računar optimalno koristio, treba ga prilagoditi našim uslovima i 
standardima. Osnovno je obezbediti ispravno prikazivanje svih naših slova 
na ekranu i u izlaznim dokumentima i obezbediti raspored slova na tastaturi 
koji odgovara našim navikama. Poželjno je i da prikazivanje datuma, 
vremena, sortiranje podataka i oznaka valuta u finansijskim programima 
odgovaraju našim standardima.WINDOWS 9x ovo omogućava, ali ne za sve 
zemlje sveta u jednom paketu. Postoji više verzije operativnog sistema koje 
su prilagođene raznim tržištima. Osnovna američka verzija obezbeđuje 
podršku za zapadnoevropske zemlje, Rusiju, Grčku i slično. Podrška za 
Jugoslaviju se nalazi u tzv. panevropskoj verziji paketa koji se nabavlja na 
poseban zahtev pa to treba naglasiti isporučiocu softvera pri kupovini. 

4.1 Instalacija fontova 
 

Verzija WINDOWS 9x namenjena američkom tržištu može se prilagoditi 
našim uslovima, ali tek uz pomoć dodatnih alata domaćih autora i 
doinstalacije Multilanguage Support modula koji se standardno isporučuje. 
Osnovne kolekcije slova koje se instaliraju iz američke verzije paketa ne 
sadrže u sebi naša karakteristična slova šćđžč. Međutim, postoje i proširene 
kolekcije istih fontova koje se dobijaju instalacijom Multilanguage Support 
modula. Ako to niste uradili u toku instalacije, pokrenite Start->Settings-
>Control Panel sistemske aplikacije i izborom Add/Remove Programs-
>Windows Setup opcije. 

Na listi raspoloživih modula WINDOWS 9x treba odabrati Multilanguage 
Support modul i pritiskom na dugme Details pojaviće se lista raspoloživih 
internacionalnih podrški. 

Treba odabrati Central European Language Support (kodna strana 1250) i 
Cyrilic language support(kodna strana 1251). Ove dve kolekcije u sebi ne 
sadrže našu zemlju, ali sadrže fontove sa našim latiničnim (CP1250) i 
ćiriličnim slovima (CP1251) što je dovoljno bat za početak. 

Izborom tastera OK i još jednom OK dodaće se međunarodna podrška za 
ove zemlje i postojeći True Type fontovi proširiti dodatnim slovima. Ovi 
fontovi su modifikacija postojećih i biraju se tokom rada u nekoj aplikaciji 
preko Script opcije ili dodataka u nazivu. Za rad sa latinicom treba odabrati 
Central European (CE) verziju fonta, a za rad sa ćirilicom Cyrillic (Cyr). 

4.2 Podešavanje tastature 
Da bi se naša slova mogla i otkucati, treba prilagoditi tastaturu, odnosno 
dodeliti YU slova nekim tasterima, uz privremeno isključivanje manje 
važnih slova iz standardnog rasporeda tastature. 

Iz Control Panel aplikacije se pokrene opcija Keyboard i odabere Language 
panel. Na Language listi bi trebalo da se nalazi standardni tastaturni 
raspored, a novi se dodaje pritiskom na taster Add i izborom opcije 
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Slovenian iz padajuće liste. Na taj način dobijaju se dva raspoloživa 
rasporeda na tastaturi koji se po pootrebi prebacuju odabranom 
kombinacijom tastera (npr. Left Alt+Shift) ili klikom na mali indikator sa 
skraćenim nazivom zemlje na taskbar-u. 

4.3 Ostale nacionalne karakteristike 
Podešavanje ostalih YU karakteristika (format datuma,vremena...) se 
obavlja iz Control Panel-a, preko opcije Regional Settings. Potpuno 
podešavanje se najlakše izvodi u panevropskoj verziji WINDOWS 9x, tako 
što se izabere Srbija u kontrolnom panelu. U američkoj verziji se može 
ručno podesiti način ispisa za neke od formata koji nam najviše odgovara u 
panelima Number (prikaz brojeva), Currency (prikaz novčanih suma), Time 
(prikaz vremena) i Date(prikaz datuma). Međutim, ovo rešenje nije baš 
savršeno, jer se recimo ne mogu dobiti nazivi dana u sedmici na našem 
jeziku. 

Takođe ne postoje naša slova u sistemskim fontovima za ispis menija, 
naziva, terminal prozora i sl. Ovo se može rešiti ubacivanjem *.FON 
datoteka iz neke Windows CEE verzije ili editovanjem postojećih. 
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5. Explorer 
Explorer je osnovna sistemska aplikacija koja služi za organizovanje 
podataka na računaru, kopiranje i premeštanje datoteka i kataloga, osnovni 
pregled sadržaja, formatiranje disketa, razna podešavanja perifernih uređaja 
i uopšte - održavanju sistema. Explorer se pokreće iz Start menija izborom 
opcije Programs, a zatim Explorer. Alternativno, može se pokrenuti i 
dvostrukim klikom na folder na desktopu. 

5.1 Rad sa datotekama 
Explorer se sastoji iz dva panela, gde levi služi za hijerarhijski pregled i 
izbor objekata (diskovi, katalozi, mrežni serveri, svi objekti na desktopu 
itd.), dok se u desnom panelu prikazuje sadržaj trenutno izabranog objekta 
(katalozi, radne stanice, datoteke, ...). Format sadržaja prikazivanja se može 
izabrati preko opcije View u meniju. Iz istog menija, opcijom Arange Icons, 
može se izabrati način slaganja ikona koji može biti prema nazivu, tipu, 
veličini ili datumu poslednje izmene. 

Levi panel je organizovan u obliku stabla prema logičnoj hijerarhiji 
objekata. Ukoliko neka grana na stablu sadrži “podgrane” koje nisu 
prikazane, pored nje se nalazi mali znak (+). Klikom na plus otvara se 
sledeći hijerarhijski nivo, i znak plus prelazi u minus (-) preko kog se nivo 
može ponovo sažeti; isti efekti se postižu i dvostrukim klikom na objekat. 
Ukoliko prikazano stablo postane previše razgranato klikom na objekat u 
levom panelu njegov sadržaj se prikazuje u desnom. 

5.2 Otvaranje objekata 
Objekti u desnom panelu “otvaraju” se dvostrukim klikom miša. Zavisno od 
tipa objekta, “otvaranje” podrazumeva ulazak u sledeći hijerarhijski nivo 
ukoliko se radi o katalogu, izvršavanje ukoliko je objekat neki program ili 
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učitavanje u odgovarajuću aplikaciju ukoliko se radi o nekoj vrsti 
dokumenata ili crteža. Operativni sistem će pokušati da prepozna tip 
dokumenata na osnovu svoje liste, pokrenuće aplikaciju koja odgovara 
prepoznatom tipu i učitati dokumenat; isti efekat postiže se i preko 
menija.Ukoliko ne prepozna tip datoteke, Explorer će prikazati dijalog za 
ručno dodeljivanje dotičnog tipa nekoj od instaliranih aplikacija. 

5.3 Kopiranje i premeštanje 
Kopiranje objekata u Explorer-u moguće je na više načina: 

• Selektuje se željeni objekat (dokument ili datoteka) i izabere se 
opcija Copy iz Edit menija (Edit>Copy). Pozicoinirate se u fasciklu 
gde želite da iskopirate objekat i izaberete opciju Paste iz Edit 
menija (Edit>Paste). 

• Selektuje se željeni objekat (dokument ili datoteka) i pritisnete 
kombinaciju tastera Ctrl+C (Copy). Pozicoinirate se u fasciklu gde 
želite da iskopirate objekat i pritisnete kombinaciju tastera Ctrl+V 
(Paste). 

• Selektuje se željeni objekat (dokument ili datoteka) i izabere se 
opcija Copy toolbar-a. Pozicoinirate se u fasciklu gde želite da 
iskopirate objekat i izaberete opciju Paste tolbara-a. 

• Selektuje se željeni objekat (dokument ili datoteka), postavite 
pokazivač miša na selektovani objekat i kliknete na desni taster 
miša. Iz padajućeg (Pop-up) menija i izabere se opcija Copy. 
Pozicoinirate se u fasciklu gde želite da iskopirate objekat, postavite 
pokazivač miša na prazan prostor u denom panelu Explorer-a i 
kliknete na desni taster miša. Iz padajućeg (Pop-up) menija i izabere 
se opcija Paste . 

• Kopiranje se može uraditi i tako što selektovani objkat iz desnog 
panela Explorer-a prevuče na neki disk (npr. A) ili drugi katalog u 
levom panelu. Za lakše snalaženje mogu se pokrenuti dva Explorer  
prozora, tako što se dvaput izabere Explorer,a zatim premešta objekt 
iz jednog u drugi. 

Ukoliko se objekat prevuče na drugu lokaciju istog diska, on će biti 
prenesen a ne prekopiran. Premeštanje podrazumeva kopiranje na 
novu lokaciju i brisanje polaznog objekta na postojećoj; ako želite da 
napravite kopiju datoteke, to treba da naglasite tako što držite 
pritisnut Ctrl. 

Često se mišem uhvati pogrešan objekat i krene u prevlačenje. 
Ukoliko se na pola puta uoči greška i objekat jednostavno pusti, on 
će biti prekopiran ili premešten na mesto na kome je kursor trenutno, 
što može da zbuni početnika! Prekid operacije treba izvoditi 
pritiskom na taster Esc. Zbog svega toga je preporučljivo, da kod 
ovih operacija premeštanja i kopiranja koriste desni taster miša, čime 
će pre svake operacije biti upitani za potvrdu preko posebnog 
dijaloga. 
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5.4 Promena naziva i uklanjanje objekta 
Promena naziva objekta (rename) izvodi se klikom na već selektovani 
objekat, pritiskom na F2 ili izborom iz menija. Brisanje (tačnije, 
premeštanje u Recycle Bin) izvodi se pritiskom na taster Del, klikom desnim 
tasterom i izborom Cut opcije ili iz osnovnog menija. Mogu se brisati 
datoteke i katalozi, a ne i ostali objekti. Pritom se brisanje svodi na 
premeštanje objekta u specijalni katalog Recycle Bin, gde se čuvaju dok na 
disku ima mesta za slučaj da ih treba vratiti nazad. 

5.5 Pronalaženje datoteka 
Jedna od najmoćnijih opcija Explorer-a je 
pretraživanje diskova (search). Mogu se 
tražiti datoteke i katalozi na lokalnom 
računaru, ali i na računarima unutar mreže i 
datoteke na njima. Pretraživanje se zadaje 
komandom Tools -> Find i izborom objekta: 
datoteka ili katalozi, računari u mreži MS 
Network servis. Najinteresantnije je 
pronalaženje datoteka.  

U prvom panelu Name & Location zadaje se oblast pretraživanja u polju 
Look in. Može se odabrati ceo sadržaj svih diskova u računaru ili samo neki 
od njih ili pojedini direktorijum sa ili bez poddirektorijuma. U polju Named 
može se zadati naziv ili bar deo naziva datoteke ili kataloga koji se traži. 

U sledećem panelu Date Modified određuje se kriterijum pretraživanja 
prema datumu poslednje izmene datoteke. Mogu se tražiti sve datoteke 
između zadatih datuma, tokom prethodnih x meseci ili dana. 

U trećem panelu se zadaju još neki dodatni kriterijumi, koje nećemo 
navoditi. 

5.6 Formatiranje disketa 
Izborom objekta tipa disk i klikom na desni taster 
miša dobija se meni iz koga se mogu izvesti neke 
specifične operacije kao što je formatiranje diskete. 
Format naredbom se dobija dijalog prozor za 
podešavanje raznih parametara formatiranja. To su 
kapacitet diskete, brzo brisanje liste sadržaja ili 
potpuno formatiranje sa proverom ispravnosti cele 
diskete, kopiranje sistemskih podataka na disketu bez 
formatiranja ili sa formatiranjem čime se dobija 
startna boot disketa sa koje se može podići sistem. 

Pored disketa mogu se formatirati i particije na disku, 
osim one koja sadrži sam Windows. 
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5.7 Osobine objekata (Properties) 
Za svaki objekat može se dobiti lista njegovih osobina bez obzira da li je u 
pitanju datoteka, katalog, disk i dr. Klikne se desnim tasterom miša na 
objekat i odabere komanda Properties ili pozove komanda iz menija. 

Dobija se dijalog čiji sadržaj zavisi od konkretnog objekta koji je u pitanju. 
Pored navođenja raznih informacija o datoteci mogu se podesiti njeni 
atributi ili saznati verzija i proizvođač. 

5.8 Priprema slika - Paint 
Program Paint služi za pregled slika, jednostavno crtanje, pripremu manje 
složenih ilustracija i šema za dokument, izradi tapeta za radnu površinu 
ekrana i slično. On radi sa grafičkim datotekama u BMP, RLE i PCX 
formatima, takozvanim bit mapiranim zapisima slike, zasnovanim na opisu 
boje svake od tačaka koja sačinjava crtež. Format BMP je standardni format 
direktnog zapisa, RLE format podrazumeva kompresiju pa datoteka zauzima 
manje prostora na disku, dok je PCX standardni format za PC grafiku nastao 
iz programa PC Paintbrush. Paint može da snima BMP format datoteka u 
crno-belom formatu ili u 16, 256 i 16.7 miliona boja. 

Osnovni alati za crtanje se biraju iz “kutije za alat”, pritiskom na 
odgovarajuće dugme. Naziv alata se dobija tako što se kursor zadrži par 
sekundi iznad njega, a kratki opis funkcije se pojavljuje u poslednjem redu 
prozora. Tu su komande za izbor dela slike proizvoljnog ili pravougaonog 
oblika koji se onda može premestiti ili obraditi na drugi način,kantica za 
popunjavanje zatvorenih površina, gumica za brisanje dela slike, pipeta za 
izbor neke od postojećih boja na crtežu i lupa za uvećanje slike radi 
preciznije obrade. 

Slede alati za crtanje: olovka koja se koristi kao i prava, četka za izvlačenje 
debljih linija i “malanje”, prskanje sprejom i upis teksta na sliku, pri čemu 
se pojavljuje dodatni dijalog za izbor tipa i veličine slova. Postoje alati za 
crtanje elementarnih geometrijskih figura kao što su prava i kriva linija, 
pravougaonika, poligona, elipse i krugova uz pritisnut Shift i na kraju 
pravougaonik sa zaobljenim uglovima. 
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6. Podešavanje sistema 
WINDOWS 9x je prilagodljiv operativni sistem. To znači da se prema 
potrebama i ukusu korisnika mogu podesiti načini prikaza, sadržaji lista 
komandi, nacionalne karakteristike, osobine i performanse priključenih 
uređaja i razne druge opcije. 

6.1 Podešavanje Taskbar-a 
Komandni panel WINDOWS 9x operativnog sistema se inicijalno nalazi u 
dnu ekrana i kao što je rečeno, služi za pokretanje aplikacija, prikaz aktivnih 
i njihovo biranje. 

Način funkcionisanja, položaj i veličina taskbar-a može se prilagoditi 
potrebama. Komandom Start -> Settings -> Taskbar se dobija dijalog za 
podešavanje taskbar osobina. Isti dijalog se može dobiti desnim klikom 
miša na slobodan deo taskbar-a i izborom opcije Properties iz liste. 

6.2 Podešavanje Start menija 
Osnovna lista iz koje se pokreću sve instalirane aplikacije, dobija se 
pritiskom na dugme Start na levom delu taskbar-a. Iz nje se može pokrenuti 
traženje neke datoteke, kataloga računara itd.  

Svi ostali instalirani progami se mogu pokrenuti iz Start liste i to na dva 
načina: izborom Run opcije i ukucavanjem komande ili izborom iz 
Programs liste instaliranih aplikacija. 

Komanda Run prikazuje dijalog za zadavanje naziva programa ili podacima 
za koje postoji definisana aplikacija kojom se obrađuju. Ukoliko se tačan 
naziv ne zna dugmetom Browse se može potražiti konkretna datoteka. 

Za pokretanje instaliranih aplikacija u računaru predviđen je jednostavniji 
metod - biranjem iz liste Programs mišem ili kursorskim tasterima. Njen 
sadržaj se može ažurirati na više načina: instalaciona procedura operativnog 
sistema će tokom ubacivanja novog programa u računar automatski dodati i 
odgovarajuću stavku u Programs listu. 

6.3 Control Panel 
Pri razvoju WINDOWS 9x posebna pažnja je posvećena 
prilagođavanju ukusu korisnika i njegovom načinu 
organizovanja radne okoline - može se podesiti veliki broj 
parametara koji utiču na performanse pojedinih komponenti 
računarskog sistema. Skoro sva podešavanja obavljaju se 
posredstvom sistemske aplikacije zvane Control Panel. 

 

Control Panel je specijalni objekat u kome su koncetrisani 
sistemski programi za konfigurisanje. Kada se otvori pojavljuje 
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se prozor čiji sadržaj zavisi od instaliranih uređaja, odnosno programskih 
modula samog WINDOWS 9x. 

6.4  Datum i veme 
Ispod ikone Date/Time krije se program za podešavanje sistemskog datuma 
i vremena, kao i vremenske zone. Sistemsko vreme koriste svi programi, pa 
je bitno da ono bude ispravno podešeno. Posebna pažnja “usaglašavanju 
vremena” posvećuje se višekorisničkim sistemima i mrežama. 

Sama upotreba ove aplikacije je veoma jednostavna: izabere se dan, mesec, i 
godina i u odgovarajućem polju unese tačno vreme. Interesantna je i 
mogućnost podešavanja vremenske zone koja je važna ukoliko se šalje 
elektronska pošta. 

6.5 Podešavanje ekrana 
Veoma važan konfiguracioni program bavi se podešavanjem parametara 
ekrana. Podeljen je u četiri “lista” za podešavanje dezena podloge 
(Background), zaštite ekrana kada se računar ne koristi (Screen saver), 
načina prikaza elemenata prozora (Appearance) i izbor grafičke rezolucije 
(Settings). 

6.5.1 Background 
 

Ako grafički operativni sistem pokušava da simulira radni sto, 
onda možemo reći da ova opcija služi za izbor stolnjaka. Naime, 
podešava se izgled pozadine ekrana iznad koje se otvaraju prozori 
aplikacija. Pozadina može da bude jednobojna, prožeta šrafurom 
ili sastavljena od grafičkih elemenata poput tapeta. Dezeni se 
biraju iz jedne od dve padajuće liste na kojoj su nabrojane sve 
mogućnosti. Tu je i mali prikaz ekrana na kome se može proveriti 
kako će on izgledati pre nego što se izbor primeni na stvarni 
ekran. 

6.5.2 Screen saver 
Ova opcija je postala popularna poslednjih godina iako u suštini nije 
neophodna. Naime, ako je slika prikazana na ekranu uglavnom statična, 
osvetljeni su uvek isti delovi ekrana pa se ekranski premaz na tim mestima 
više troši. Da bi se ekran štedeo, treba ga zatamniti kada se računar ne 
koristi ili bar pustiti neku animaciju koja ravnomerno opterećuje ekran. Ovo 
se automatizuje tako što operativni sistem prati aktivnosti korisnika i 
ukoliko je on neaktivan tokom zadatog perioda, automatski uključuje 
odabranu animaciju. Izlazak iz Screen saver moda, tj. “buđenje” računara 
postiže se pritiskom bilo kog tastera ili pomeranjem miša, posle čega se 
vraća normalni ekran. 
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6.5.3 Appearance 
U ovom panelu se podešava vizuelni izgled svih standardnih grafičkih 
elemenata WINDOWS 9x. To su delovi prozora, okviri, naslovi aktivnih i 
neaktivnih aplikacija, ikone, meniji, boja pozadine i mnogi drugi. Dakle, 
ono što se podesi u ovom panelu uglavnom definiše izgled svega što radi 
pod WINDOWS 9x.  

6.6 Settings 
Ovo je najvažniji panel Display aplikacije: u njemu se biraju sistemske 
osobine grafičkog podsistema kao što su rezolucija, broj boja i slično. 
Rezolucija u kojoj radimo definiše “finoću” prikaza preko broja tačkica od 
kojih se slika na ekranu sastoji: ako se izabere više tačkica, one će biti 
sitnije pa će slika biti finija, ali će rad biti sporiji jer računar mora da 
obrađuje više podataka. 

Izbor rezolucije, dakle, zavisi od modela grafičke karte i kvaliteta monitora. 
Tipipčno se rezolucija podešava na 640 tačaka po horizontali i 480 tačaka 
po vertikali ili 800x600 tačaka; ove vrednosti podržavaju praktično sve 
danas raspoložive grafičke kartice i monitori. 

Drugi bitan kvalitet prikaza je broj boja koje se istovremeno mogu prikazati 
na ekranu, [to opet zavisi od tipa grafičke kartice. Svaki model omogućava 
rad sa 16 i 256 boja, mada ima kartica sa većim brojem boja. 

WINDOWS 9x će tokom instalacije “prepoznati” tip grafičke kartice i 
monitora, ali je njegov izbor poželjno proveriti; po potrebi se u 
odgovarajućem prozoru podešavaju precizne vrednosti. Pošto podesite sve 
što je potrebno, izaberite OK ili odustanite sa Cancel; promena grafičkog 
moda često zahteva resetovanje računara, na šta će vas upozoriti i sama 
aplikacija. 

6.6.1 Podešavanje miša 
Preko Mouse ikone pokreće se sistemska aplikacija za podešavanje 
ponašanja miša, koja se sastoji iz četri panela. U prvom, bira se 
normalan ili levoruki položaj tastera, čime se zamenjuju funkcije 
levog i desnog tastera miša. Preko klizača se podešava dozvoljena 
brzina dvoklika, vreme koje sme da protekne između dva pritiska na 
levi taster miša.  

U Panel Motion panelu podešavate osetljivost miša, odnosno 
koeficijenat koji određuje koliko se pomera pokazivač na ekranu u 
odnosu na pomeranje miša na stolu. 

Panel General služi za izbor modela miša koji se koristi i eventualnih 
dodatnih opcija koje dotični model i njegov drajver podržavaju: pretvaranje 
pokazivača u lupu za zumiranje, fina kontrola položaja, prelazak na 
suprotnu ivicu ekrana pri izlasku sa njega i slično. 
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6.7 Rad sa fontovima 
Font Manager je sistemska aplikacija namenjena pregledu, instalaciji i 
uklanjanju raznih oblika slova (fonts) koji se mogu koristiti pod WINDOWS 
9x i svim njegovim aplikacijama. 

6.7.1 Vrste fontova 
Osnovni prozor Font Manager-a sadrži listu trenutno instaliranih fontova u 
obliku malih ili velikih ikona i naziva. Prema ikoni se može prepoznati i tip 
fonta: posebno su značajni True Type fontovi (ikona sa natpisom TT) u 
kojima je svako slovo definisano matematičkim formulama koje opisuju 
krive linije oblika slova. Druga vrsta fontova su bitmapirani, predstavljeni 
ikonom sa slovom A. Kod njih su sva slova definisana sličicama, pa se 
prikazuju bez ikakvog proračunavanja. 

6.7.2 Pregled fontova 
Font za pregled bira se dvostrukim klikom 
miša na njegovu ikonu, dovođenjem kursora 
do nje i pritiskom na Enter ili iz menija. 
Pojavljuje se novi prozor u kome su prikazana 
osnovne karakteristike dotičnog fonta. Najpre 
je dat naziv, preko koga se font referencira u 
aplikacijama. Sam izgled slova je dat u obliku 
engleskog abecednog niza i brojeva.  

 

6.7.3 Instalacija fontova 
Fontove koje ćete koristiti morate najpre da instalirate tj. uključite u 
operativni sistem posredstvom Font Manager aplikacije. Instalacija se 
izvodi preko File -> Install New Fonts komande u meniju; pojavljuje se 
dijalog u kome treba najpre locirati disk i katalog u kome se nalaze datoteke 
sa novim fontovima. Klikom levog tastera miša na željeni font on se 
označava i pritiskom na dugme OK instalira i pojavljuje u listi Font 
Manager-a. Odjednom može da se izabere više fontova koji će onda biti 
instalirani u paketu: klikćete na svaki od njih redom držeći pritisnut 
tasterCtrl.  

Nepotrebni fontovi se uklanjaju tako što se selektuju i izbere File -> Delete 
komanda iz menija. Treba biti pažljiv da se ne ukloni neki od bitnih 
sistemskih fontova bez koji računar neće ispravno funkcionisati. 
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7. Rad sa štampačem 
Podrška štampača je ugrađena u sam operativni sistem WINDOWS 9x 
koji pruža usluge te vrste svim ostalim aplikacijama. To znači da se izbor 
i konfigurisanje štampača obavlja odgovarajućim WINDOWS 9x 
konfiguracionim programom, a sve aplikacije zatraže uslugu štampanja 
kada je potrebna, bez ikakvih dodatnih podešavanja.  

Kod nekih aplikacija se nudi poseban dijalog za podešavanje opcija (broj 
kopija, štampanje celog dokumenata ili njegovog dela, parnih i neparnih 
strana i slično). Neki složeniji programi su posebno osetljivi po pitanju 

kvaliteta štampanja. Ipak, za najveći broj primena, sva aktivnost oko izbora i 
podešavanja štampača obavlja procedurom operativnog sistema, koja se 
pokreće tokom instalacije WINDOWS 9x. 

7.1 Izbor i instalacija štampača 
Komandom Start -> Settings -> Printers dobija se katalog sa listom trenutno 
podržanih štampača, odnosno njihovih drajvera. Svaki ima svoju ikonu na 
kojoj je eventualno posebnim simbolom naznačeno da se radi o mrežnom 
štampaču (konektor i kabl), štampanju u datoteku (disketa) i slično. 

Ikona Add Printer služi za pokretanje sistemske aplikacije koja vodi kroz 
postupak instaliranja podrške za novi štampač. Procedura je slična drugim 
podešavanjima: pritiska se dugme Next za prelazak na sledeći korak i usput 
bira po neka opcija, a na prethodni dijalog se vraća sa Back. 

Najpre će se postaviti pitanje da li instalirani štampač lokalni ili mrežni. 
Opisaćemo postupak instaliranja lokalnog štampača. 

Sledi ključni dijalog - izbor proizvođača i konkretnog modela štampača koji 
je u pitanju. Pogrešan izbor i podešavanje će doneti mnoge neočekivane 
probleme u radu, štampanje raznih brljotina, nekontrolisano izbacivanje 
papira, štampanje samo dela strane i itd. 

Najpre se u levoj listi odabere proizvođač, a onda u desnoj neki od modela. 
Ukoliko instalirani model ne postoji na listi, odaberite neki koji ima slične 
karakteristike. Ukoliko se uz štampač dobili diskete sa Windows drajverima 
možete kliknuti na Have Disk i upotrebiti te drajvere umesto sistemskih. 

Sledi zadavanje komunikacijskog porta na koji je štampač priključen. U 
najvećem broju slučajeva koristi se prvi paralelni port (LPT1) koji je 
namenjen štampačima, mada neki modeli mogu koristiti i serijski port. 
Dugmetom Configure Port se eventualno podešavaju neke osobine porta i 
način njegovog tretiranja. Sledi zadavanje imena pod kojim će se štampač 
javljati u listi raspoloživih. 

Pritiskom na dugme Finish dovršava se instalacija kopiranjem potrebnih 
veznih programa iz paketa WINDOWS 9x ili aktiviranjem postojećih, 
ukoliko su već instalirani. 
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7.2 Podešavanje štampača  
Parametri štampača i način njegovog korišćenja dobijaju se komandom File 
-> Properties ili desnim klikom miša na ikonu štampača i izborom stavke 
Properties iz liste. Ovi parametri zavise od konkretnog modela koji je u 
pitanju. Najvažnije opcije standardnog laserskog printera prikazane su na 
slici. 

7.3 Rukovanje papirom 
Rezultat štampanja je ispisan papir. Zato u ovom panelu treba podesiti 
njegove dimenzije (Paper size), jer se umesto Letter formata kod nas 
najčešće koristi A4. Ispis na papir može biti “normalan” (Portrait) ili “po 
dužini” (Landscape). 

Način doturanja papira štampaču se zadaje u listi Paper source, a može biti 
ručni ili uvlačenjem iz kasete. Ekonomični mod štampe pri kome se štedi 
toner ali dobijaju i nešto bleđe kopije se bira u listi, kao i podrazumevani 
broj kopija. 
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8. Održavanje diska 
Najvrednija stvar na računaru su podaci uneti od strane korisnika; 
uostalom,računari se i nabavljaju da bi se obrađivali podaci. Podaci se 
memorišu u jedinicama memorije od kojih je, zbog kapaciteta i brzine, 
najzastupljeniji hard disk, mada se koriste i drugi uređaji (diskete,trake,CD-
ROM itd). 

Održavanju hard diska treba strogo posvetiti značajnu pažnju. Sama 
struktura zapisivanja podataka je prilično složena i osetljiva na greške koje u 
najvećem broju slučajeva nastaju nepropisnim zatvaranjem datoteka sa 
upisanim podacima. Do toga može doći u slučaju nestanka struje, 
resetovanja računara, zaglavljivanja aplikacije ili neke greške u njoj. 
Mogući su i problemi u samim uređajima i njihovim veznim adapterima 
(kontrolerima), ali kod dobro komponovanog i podešenog sistema problemi 
tog tipa nisu naročito verovatni. Ipak, treba preduzeti sve da se oni 
preduprede a njihove eventualne posledice umanje. 

Pogledajmo, dakle, šta se sve može učiniti upotrebom raspoloživih 
WINDOWS 9x sistemskih aplikacija za bezbednost podataka, ispravno i 
efikasno funkcionisanje hard diska. 

8.1 Backup 
Osnovni postupak za očuvanje bezbednosti podataka u svim uslovima i 
njihovu zaštitu od svih mogućih problema postiže se jedino redovnim 
pravljenjem rezervnih kopija sadržaja hard diska ili bar datoteka sa unetim 
podacima. Za tu namenu predviđen je sistemski program Backup koji se 
pokreće preko Start->Programs->System Tools->Backup. 

Aplikacija se sastoji iz tri osnovna panela za pravljenje kopija (Backup), 
njihovo restauriranje (Restore) i poređenje sadržaja originala i kopija 
(Compare).  

Kopija podataka kreira se u svega par koraka, na panelu Backup. Najpre se 
odaberu diskovi, katalozi i datoteke koje treba prebaciti, sa ekrana koji 
podseća na Explorer: u levom delu je hijerarhijska lista objekata, a u 
desnom njihov sadržaj. Selekcija za backup postiže se klikom miša na 
prazan kvadratić uz objekat, pri čemu on postaje zatamljen (chek-iran) što 
označava da je odabran. 

Kada je izbor načinjen, pritiskom na Next Step prelazite na izbor uređaja za 
backup. Može se odabrati bilo koji raspoloživi uređaj ili katalog sa liste u 
levom delu, recimo neki drugi hard disk, mrežni server ili flopi preko koga 
će se podaci kopirati na diskete. 

To je ujedno i pravi trenutak da se lista datoteka za kopiranje na ciljni uređaj 
snimi u posebnu konfiguracionu datoteku, File -> Save komandom iz 
menija. Pri sledećem pravljenju buckup-a nećete morati ponavljati čitav 
postupak, već ćete sa File -> Open File Set učitati datoteku. 
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Ostaje još da pritisnete Start Backup i procedura počinje ... potrajaće 
zavisno od količine podataka i brzine prenosa. 

8.2 Restauracija sačuvanog sadržaja 
Sačuvani podaci se, u slučaju potrebe, mogu vratiti na disk preko Restore 
panela. Sličan je prethodnom, osim što treba izabrati lokaciju gde se nalazi 
kopija (obično datoteka ima ekstenziju .QIC). U desnom prozoru biće 
prikazan njen sadržaj odakle se mogu odabrati katalozi i datoteke koje se 
vraćaju nazad. 

8.3 Provera i poređenje sadržaja 
Treći panel Compare služi za poređenje sadržaja diska i prethodno 
napravljenih backup kopija. U levom delu se odabere uređaj na kome se 
nalazi kopija. U sledećem koraku (Next) se odabere sadržaj kopije koji se 
poredi sa originalom na disku i pokrene procedura dugmetom Start 
Compare. Po završetku poređenja biće generisan izveštaj. 

8.4 Podešavanje opcija 
Pre rada sa backup aplikacijom treba podesitii razne parametre njenog 
ponašanja, što se obavlja u dijalog prozoru Settings -> Options koji se 
sastoji od četri panela. U General panelu se samo uključuje zvučna 
signalizacija toka rada i specificira da li će novi izveštaj o toku backup 
procedure prebrisati prethodni. Mnogo je interesantniji Backup panel za 
podešavanje opcija same procedura pravljenja kopija. Pored standardnog 
kopiranja svih odabranih datoteka postoji i inkrementalno ili diferencijalno 
kopiranje. Izborom ove opcije ne kopiraju se sve datoteke na medijum za 
backup, već samo one koje su izmenjene u odnosu na prethodno kopirani 
sadržaj. 

Restore panel služi za određivanje opcija pri vraćanju podataka iz arhive na 
diskove. Najpre u Restore backed up files to treba odabrati da li se podaci 
vraćaju na svoje originalne lokacije, tj. U kataloge iz kojih su snimljeni, na 
neko drugo mesto ili sve u isti katalog. Može se zadati da se samo starije 
verzije automatski zamenjuju, za šta je bitno da sistemsko vreme računara  
uvek bude ispravno podešeno, a može se  i zabraniti bilo kakvo prepisivanje 
postojećih disketa. 

8.5 Provera konzistentnosti podataka 
Osnovni alat za proveru ispravnosti strukture zapisa podataka 
na disku je sistemska aplikacija Scan Disk; osim pasivne 
provere, ovaj program će otkloniti većinu jednostavnih 
problema. Nekonzistentnosti u zapisu najčešće nastaju 
neregularnim završetkom rada računara, zbog grešaka u 
programima i samom operativnom sistemu ili zbog problema i 
nepodešenosti u samom uređaju. Ovi problemi se manifestuju 
kao nepropisno zatvorene datoteke čija se veličina ne slaže sa 
deklarisanim zauzetim prostorom, neispravan sadržaj kataloga, 
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itd. 

Sve ove probleme ScanDisk otkriva i popravlja, a uzgred i testira ispravnost 
diska, označava nepouzdane delove, restaurira oštećene podatke i slično. 
Zato je poželjno što češće ga aktivirati, recimo jednom dnevno, pri 
uključenju računara. ScanDisk se startuje preko Startup->Programs-
>SystemTools->ScanDisk. Iako program može da se koristi u paraleli sa 
drugim aplikacijama, preporučuje se njegovo korišćenje onda kada su ostale 
aplikacije zatvorene. 
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9. Razmena podataka 
Operativni sistem WINDOWS 9x u isto vreme može da izvršava više 
poslova, što znači da se istovremeno mogu pokrenuti više aplikacija. Jedna 
od njegovih prednosti su široke mogućnosti razmene podataka između tih 
programa: dokumenti ili njihovi delovi mogu da se prenose iz jedne 
aplikacije u drugu na jednostavan način i da se pri tome u najvećoj mogućoj 
meri očuva njihov sadržaj, format i osobine. Može se razmenjivati čist ali i 
formatirani tekst, slike, tabele i slično. 

9.1 Zajednička oglasna tabla - Clipboard 
Najednostavnija je razmena preko zajedničke “oglasne table” koja se zove 
Clipboard. To je u stvari jedan segment memorije (bafer) u koji svaka 
aplikacija može da pošalje podatke ili da iz njega učita, ako ih tamo ima. 

Selektujte, recimo deo dokumenta i onda ga komandom Edit -> Copy ili 
Edit -> Cut, prekopirate ili prebacite u Clipboard, odakle se može preneti na 
drugo mesto komandom Edit -> Paste. Pošto Cut, Copy i Paste komande 
ima svaka Windows aplikacija koja radi sa doku mentima i podacima, one su 
uniformno rešene na nivou operativnog sistema, što omogućava prenos 
podataka između potpuno različitih aplikacija. Dovoljno je u jednoj poslati 
neki sadržaj na Clipboard, preći u drugi i učitati ga. 

Clipboard u jednom trenutku može da čuva samo jedan segment podataka, 
pa poslati sadržaj ostaje na njemu sve dok ne stigne neki novi ili dok se 
Clipboard posebnom komandom ne obriše. Može se, iz jedne aplikacije 
nešto upisati a onda to iskoristiti u više drugih programa. 

Ponekad je korisno pregledati šta se nalazi na Clipboard-u, za šta je 
obezbeđena sistemska aplikacija zvana Clipboard Viewer. Pored uvida u 
trenutni sadržaj Clipboard-a, ovde se omogućuje snimanje tog sadržaja u 
posebnu .CLP datoteku, odakle se kasnije može ponovo učitati u Clipboard. 
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10. Korišćenje DOS programa 
DOS radna okolina za WINDOWS 9x predstavlja samo jednu od aplikacija 
koje se trenutno izvršavaju. Pokreće se komandom Start -> Programs -> 
MS-DOS Prompt. Pojavljuje se prozor sa komandnom linijom koji je 
praktično isti kao radni ekran standardnog DOS-a. 

Ovaj prozor može biti unatar desktop-a ili na celoj površini ekrana uz 
prebacivanje grafičke kartice u tekstualni mod, kada je radna okolina još 
sličnija, a emulacija potpunija. Prelaz između ova dva moda obavlja se 
kombinacijom tastera Alt+Enter. 

Izlazak iz “DOS-a”, odnosno završetak rada njegove emulacije, regularno se 
izvodi kucanjem komande Exit, a u slučaju potrebe se može prekinuti i 
standardnim komandama za prekid WINDOWS 9x aplikacija. Nasilni 
prekid treba izbegavati, jer DOS programi koji se eventualno izvršavaju ne 
mogu da prime i obrade poruku operativnog sistema da se rad aplikacije 
završava, što može da dovede do gubitka nesnimljenih podataka. 
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11. Računarske mreže 
Trend povezivanja personalnih i drugih računara u računarske sisteme je 
prisutan već nekoliko godina, a u poslednje vreme se sve više radi i na 
globalnom povezivanju u mreže na svetskom nivou; najpoznatija globalna 
mreža zove se Internet. 

Windows 9x sadrži dorađenu i veoma jednostavnu za upotrebu podršku u 
uspostavljanju lokalnih mreža računara i povezivanje sa različitim mrežnim 
sistemim, koja je standardno ugrađena u osnovni paket operativnog sistema. 

Za razliku od ranijeg koncepta računarskih centara, današnja tehnologija 
personalnih računara uvodi koncept distribuiranih sistema. To znači da 
svaki korisnik ima kompletan računar sa svim potrebnim resursima. 
Povezivanje u mreže je u takvoj situaciji neophodno da bi se ostvarila brza i 
automatizovana razmena podataka između pojedinih računara, saradnja na 
zajedničkim poslovima, korišćenje zajedničkih baza podataka i aplikacija ... 
ukratko, obezbedile sve funkcije računarskih sistema, uz brojne prednosti i 
fleksibilnost personalnih računara. 

11.1 Postavljanje parametara mreže 
Računar čije resurse bilo koje vrste mogu i drugi koristiti naziva se server. 
Računar koji mu pristupa da bi se neki resurs koristio naziva se klijent ili 
radna stanica. Windows 9x obezbeđuje da svaki računar može po potrebi biti 
server, klijent ili oboje istovremeno. Korisnik jednog računara može 
pristupati disku računara nekog drugog korisnika, a da istovremeno treći 
član mreže koristi njegov štampač. Sve se odvija transparentno, bez 
ometanja rada njegovih aplikacija.Da bi sve ovo funkcionisalo, svi računari 
moraju biti fizički povezani i moraju biti podešeni razni organizacioni i 
komunikacioni parametri. 

11.2 Organizacija mreže 
Svaki član mreže (node) mora da ima jedinstveno ime kojim se predstavlja 
(computer name). Ukoliko je u mreži više desetina računara, treba 
obezbediti i organizaciju, što se pod Windows 9x rešava udruživanjem 
pojedinih računara u radne grupe prema nekom kriterijumu, a sve grupe 
zajedno čine jedinstvenu lokalnu mrežu. Svaki računar po potrebi, može da 
bude član više grupa istovremeno. 

Ovi podaci se unose u panelu Indetification aplikacije za mrežna 
podešavanja. U polju Computer name treba uneti jedinstveni naziv 
konkretnog računara na osnovu koga će se on prepoznavati u mreži, a u 
polju Workgroup naziv grupe kojoj pripada. Najzad, u polju Computer 
Description se može uneti proizvoljni komentar koji će videti ostali članovi 
mreže; on služi da pojasni lokaciju dotičnog računara, resurse kojima 
raspolaže ili nešto slično. 
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12. Zaključak 
Microsoft WINDOWS 9x operativni sistem i njegove prateće aplikacije 
predstavljaju impozantnu kolekciju softvera stvaranu i doterivanu 
godinama. Uz njega ide i mnogo raznih dodataka, specifičnih opcija i ređe 
potrebnih alata, koje nismo obradili u ovom uputstvu, a tu su i razne “cake” 
za brže izvođenje nekih specifičnih operacija, uz upotrebu modifikatora čije 
bi navođenje samo povećalo količinu informacija koju treba u startu 
zapamtiti. 

Ukoliko ste sagledali mogućnosti računara pod WINDOWS 9x, ovladali 
osnovnim tehnikama njegovog korišćenja i sami došli na neke ideje kako da 
ga iskoriste kao pomoć u svakodnevnim poslovima - postigli smo željeni 
cilj. Puno uspeha u radu! 


